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Section 1 Install software

The manufacturer-supplied software communicates with a number of sensors. Refer to
the manufacturer's website for the current list of sensors that use this software.
Make sure that the sensor is not connected to the USB port of the PC while the USB-
Serial driver is installed. The USB will not function correctly and communication errors will
occur.

1. Get the software from manufacturer's website or the manufacturer-supplied CD.
2. Install the appropriate software.

a. For Windows™: Double-click on the file with ".exe" appended to the name.
b. For Mac OS X: Double-click on the file with ".pkg" appended to the name. Make

sure that the default "Install for all users on this computer" is selected as the
destination for the installed software. If "Install for me only" or "Install on a
specific disk" is selected, the USB will not connect to the sensor.

3. Push Run in the new window.
The setup wizard starts.

4. Follow the on-screen instructions to install the software.

• It is only necessary to install the USB-to-Serial driver when the software is first
installed.
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Section 2 SUNA operation

W A R N I N G
 

Nitrate sensors use an ultraviolet (UV) light. Do not look directly at a UV light when it is on. It can
damage the eyes. Keep products that have UV light away from children, pets, and other living
organisms. Wear polycarbonate UV-resistant safety glasses to protect the eyes when a UV light is
on.

C A U T I O N
 

Do not supply more than 15 VDC to the sensor. More than 15 VDC will damage the wiper.

Connect the USB or RS232 cable to the PC.

• For RS232: connect the power connectors on the cable to a 8–15 VDC power supply.
• For USB: a DC power supply is only necessary for data collection. If the sensor is

equipped with internal memory, the file system will show as a USB mass storage
device on the PC.

2.1 SUNA: verify sensor operation
Do the steps below to make sure that the sensor operates, collects, and transfers data
with the settings selected by the user before further setup and deployment.

1. Connect the connectors on the cable to the bulkhead connector on the sensor and to
the PC.

2. Connect the USB or RS232 cable to the PC.
For RS232: connect the power connectors on the cable to a 8–15 VDC power supply.
For USB: a DC power supply is only necessary for data collection. If the sensor is
equipped with internal memory, the file system will show as a USB mass storage
device on the PC.

3. If necessary, start the software.
4. RS232: turn on the power supply.
5. Push Connect in the Dashboard area.
6. If necessary, change the "Sensor Type" to the connected sensor.
7. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
8. If necessary, select the communication port.
9. Push Connect.

The "Connection Mode" shows "Transition" on a yellow background, and then shows
"Setup" on a green background.

10. Select the UCI menu, then Preferences.
11. Select the [Sensor] menu, then Preferences.
12. Go to the General tab and push Browse to find or make the Default Data Directory

on the PC.
Data from the sensor is saved here.

13. Push OK.

2.1.1 General tab settings
The user can deploy the sensor in an autonomous or a logger-controlled mode.

1. If necessary, change the Operational Mode, or push Default to use the manufacturer-
set values.
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• Continuous operation—when started, the sensor operates until the user removes
power or pushes Stop in the SUNA Dashboard.

• Fixed-time operation—the sensor operates for a user-specified period of time or
number of measurements.

• Periodic operation—the sensor operates at user-specified intervals. Data
collection begins at a user-specified date and time and stops when the user
removes power or pushes Stop in the SUNA Dashboard.
Example: a sensor set up at 8:00 with a "Sample Interval" of 2 hours and an
offset of 900 seconds (15 minutes) will operate at 10:15, 12:15, 2:15, etc.

Logger-controlled modes

• Polled operation—the sensor communicates through and is controlled by an
RS232 terminal program.

• SDI-12—The sensor communicates through and is controlled by an
SDI-12 controller.

2. Select the Operational Mode Settings. The Sample Averaging and Deployment
Characteristics change as the operational settings change.

3. If the sensor has a wiper, put a check in the "Integrated Wiper Enabled" to operate
the wiper.
The wiper operates once before each measurement.

4. Use the default SUNA Messages as "INFO."
5. Push Upload to change the settings in the software.

2.1.2 Telemetry tab settings
The user can change the baud rate, data format, and SDI-12 address in the Telemetry
tab. Default values:

• "Serial Baud Rate:" 57600 
• "Transmitted Frame Format:" FULL_ASCII
• "Instrument Logging Frame Format:" FULL_ASCII
• "Log File Creation Method:" Daily
• "SDI-12 Address:" 0.

2.1.3 Advanced tab settings
The manufacturer recommends that the user change only the "Salt Water Calibration"
setting in this tab. Put a check in the "Deployed in Fresh Water" box if the sensor is
deployed in freshwater. Put a check in the "Bromide Trace" box to enable this feature.

2.2 SUNA: verify sensor collects data
1. Push Start in the Dashboard area.

The "Connection Mode" shows "Acquisition."

• Push OK so that the software shows "Temporarily enabling Transmit Real Time
Setting...". The software shows the data as it is collected in the Time Series tab.

• The Expected Data Start window shows "You will see data in approximately
103 seconds" and shows an indication of time left. This lets the sensor become
stable before it starts to collect data.

2. From the View menu, select the options to see the data:

• Real Time Data—Put a check in each box next to each parameter for which the
sensor will collect data.

SUNA operation
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• Data Logging—Push Start Log to save the collected data to the PC.

• Time Series, Spectra, and Total Absorbance graphs.
3. Put a check in the box next to any additional parameters, so that they will show in the

Time Series graph.

4. Look at the data in the Time Series graph. The user can look at data in real-time for
each sensor that has power supplied, is connected and is in communication with the
software.

• Put a check in the box next to "Time Axis" to push Zoom In and Zoom Out to
change the scale of time.

• Put a check in the box next to "Range Axis" to push Zoom In and Zoom Out to
change the scale of the data.

• To move the data in any direction, push the "Ctrl" key on the PC keyboard and
the left button of the mouse pointer at the same time.

• To select a specific part of the data to zoom in on, pull the mouse pointer
diagonally (refer to the arrow in the graph below).

SUNA operation
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• Push Auto Range to see the data for each selected parameter. The software
adjusts the scale so that the data will always show.

• Push Default Ranges to go back to the manufacturer-set default scale for each
parameter.

• Put a check in the box next to "Show Data Points" to see the value of the
collected data when the mouse moves over each point.

• Push Select Sensors To Display to change the parameters to look at in the
Time Series graph.

5. Let the sensor or sensors collect data for approximately 5 minutes.

2.2.1 Monitor data in spectra graph
The Spectra graph shows both the dark and light data in raw counts.
The dark counts are from thermal noise. The light counts are the measured output minus
the dark counts.
The measured spectrum is always flat below 200 nm, and then has four or five peaks.
The peaks are approximately 25 nm apart in the lower wavelength range and up to 50 nm
apart in the upper range.

2.2.2 Monitor data in absorbance graph
The Total Absorbance graph shows the calculated absorbance from 210 to 370 nm. This
graph is an alternative to the Spectra graph. The absorbance graph should be flat when a
sample of DI water is collected. The absorbance increases as absorbing species such as
nitrate and bromide are added to samples.

SUNA operation
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If necessary, push Stop.

2.3 SUNA: verify sensor transfers data

C A U T I O N
 

Use only the batteries recommended by the manufacturer as replacements. Do not mix new and
used cells or chemistries.

If the sensor is equipped with internal memory, the collected data is saved in the sensor.

1. Push Transfer Files in the SUNA Dashboard area.
The files saved on the sensor show on the right side of the new File Manager
window.

2. Select one or more files to copy to the PC.
The manufacturer recommends that the user use a USB connection to move the files
because it is much faster.

3. Push the <- arrow to start the move.
The status shows at the bottom of the File Manager window.

4. Open the file on the PC to make sure it has all of the collected data.

2.4 Verify precision of sensor output
To make sure that the sensor operates at optimum precision, the user must do various
checks and updates to the sensor at regular intervals.

2.4.1 Update reference spectrum
The user needs to update the reference spectrum of the SUNA at regular intervals so that
the data that the sensor collects is accurate. It may also be necessary to update the
firmware, although that is not required very frequently.

SUNA operation
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A calibration file contains the data required to convert a spectral measurement into a
nitrate concentration. The calibration data are the wavelengths of the spectrum, the
extinction coefficients of chemical species and a reference spectrum relative to which the
measurement is interpreted. The sensor can store many calibration files, but only the
active file has a green background. Push Transfer Files > File Manager, then select the
Calibration Files tab to see the list of calibration files stored in the sensor.
Make sure to clean the sensor and the sensor windows at regular intervals and before
and after every deployment. Monitor the spectral intensity of the lamp. Although the
intensity will decrease over time, make sure there are no sudden changes.
Necessary supplies:

• Power supply
• PC with software
• Connector cable for sensor–PC–power supply
• Clean de-ionized (DI) water
• Lint-free tissues
• Cotton swabs
• Isopropyl alcohol (IPA)
• Parafilm® wrap

Notes

• Use only lint-free tissues, OPTO-WIPES™, or cotton swabs to clean the optical
windows.

• Use the software to update the reference spectrum.
• Use only clean DI water that has been stored in clean glassware.
• Use Parafilm® wrap to capture DI water in the optical area of the sensor. Do not use

cups, a bucket, or a tank to collect a reference sample.

1. Clean the sensor:

a. Flush the sensor and the optical area with clean water to remove debris and
saltwater.

b. Clean the metal parts external to the optical area so that the Parafilm® will seal.
2. If the sensor has a wiper, carefully move it away from the optical area.

Figure 1  Wiper moved from optical area

3. Cut and stretch a length of approximately 40 cm (16 in.) of Parafilm®.
4. Wind several layers of the Parafilm® around the metal near the optical area.

SUNA operation
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Figure 2  Parafilm® on optical area

5. Break a small hole in the top of the Parafilm® and fill the optical area with DI water.

Figure 3  Optical area filled with DI water

6. Supply power to the sensor and use the software to operate the sensor in
"Continuous" mode.

7. Start the sensor and collect 1 minute of data.
8. Record the measurement value.

This is a "dirty" measurement to record the value when there are biofouling and
blockages in the optical area.

9. Stop the sensor.
10. Remove the Parafilm® and drain the water from the optical area.
11. Clean the optical area:

a. Use DI water or IPA and cotton swabs and lint-free tissues to clean the windows.
b. Use vinegar to clean debris such as barnacles. Be careful that the windows do

not get scratches.
12. Flush the optical area with DI water to remove any remaining IPA or vinegar.
13. Wind Parafilm® around the metal near the optical area.
14. Break a small hole in the top of the Parafilm® and fill the optical area with fresh DI

water.
15. Supply power to the sensor and use the software to operate the sensor in

"Continuous" mode.
16. Start the sensor and collect 1 minute of data.
17. Record the measurement value.

This measurement shows any sensor "drift" or change in the lamp output.
18. Stop the sensor.

SUNA operation
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19. Remove the Parafilm® and drain the water from the optical area.
20. Flush the optical area with DI water.
21. Wind Parafilm® around the metal near the optical area.
22. Break a small hole in the top of the Parafilm® and fill the optical area with fresh DI

water.
23. Supply power to the sensor and use the software to operate the sensor in

"Continuous" mode.
24. Start the sensor and collect 1 minute of data.
25. Record the measurement value.
26. Use the software to update the reference spectrum.

a. Go to the Sensor menu, then select Update Calibration.
b. Do the steps in the Calibration Wizard to update the reference spectrum.

27. If the measurement is ±2 µM (0.028 mgN/L) from the manufacturer-supplied
reference (±5 µM [0.056 mgN/L] for a 5 mm pathlength sensor), the sensor is within
the specification.
If the measurement is not within these specifications, do this procedure from step
9 until the measurement is within specification.

2.4.2 Update firmware
At regular intervals, make sure that the current firmware is installed in the SUNA. Go to
the manufacturer's web site to get the current firmware for the sensor.

1. Save the firmware to the PC.
The firmware is an ".sfw" file.

2. Make sure that the sensor is connected to the PC and a power supply.
3. Push Connect.
4. Go to the Sensor menu and select SUNA, then Advanced, then Upload Firmware

File.

5. Push Browse to find the firmware file that is saved on the PC.
6. Push Open.
7. Push Upload.

It takes approximately 2 minutes for the software to complete the upload.

SUNA operation
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8. The firmware is updated.
The software disconnects the sensor.

2.5 SUNA: set up sensor for deployment
The sensor can be attached to a cage or pipe for deployment. Make sure that the sensor
is attached correctly or the sensor may be damaged. The manufacturer recommends that
the sensor operates in a horizontal orientation.

SUNA optical area pointed sideways, and down, to reduce the collection of sediment and bio-fouling.

• Do not use the wiper as a handle.
• Do not attach the sensor to a cage or pipe at the wiper.
• Do not attach the sensor so tightly that the sensor is out-of-round. Failure of the

pressure seals can occur.
• Do not let the wiper touch any part of a cage or pipe.

1. Use cradle clamps to attach the sensor to a flat surface such as a cage.
2. Make sure that both ends of the sensor are attached to a cage or pipe. Do not leave

one end unattached, such as at the end of a pipe.
3. The user can attach the sensor to a cage with hose clamps:

• Put several layers of electrical tape around the sensor to protect the pressure
housing.

• Put clamps over the electrical tape.

The user can deploy the sensor in an autonomous or a logger-controlled mode.
Autonomous modes

• Continuous operation—when started, the sensor operates until the user removes
power or pushes Stop in the SUNA Dashboard.

• Fixed-time operation—the sensor operates for a user-specified period of time or
number of measurements.

• Periodic operation—the sensor operates at user-specified intervals. Data collection
begins at a user-specified date and time and stops when the user removes power or
pushes Stop in the SUNA Dashboard.
Example: a sensor set up at 8:00 with a "Sample Interval" of 2 hours and an offset of
900 seconds (15 minutes) will operate at 10:15, 12:15, 2:15, etc.

SUNA operation
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Logger-controlled modes

• Polled operation—the sensor communicates through and is controlled by an
RS232 terminal program.

• SDI-12—The sensor communicates through and is controlled by an SDI-12 controller.

2.5.1 Set up for autonomous deployment

1. Make sure that the sensor is connected to a power supply and PC (RS232 or USB
cable) and is on.

2. Make sure that the software is open and in communication with the sensor.
3. Push SUNA Settings in the SUNA Dashboard area.
4. Select the "Operational Mode" for the planned deployment.
5. Use the manufacturer-set values for that operation mode or change them as

necessary.

6. If the sensor has an integrated wiper, put a check in the "Integrated Wiper Enabled"
box.
The wiper operates one time data is collected, but no more than once per hour.

7. If the sensor is to be deployed in fresh water but has a calibration for seawater, select
the Advanced tab and put a check in the "Deployed in Fresh Water" box.

8. Push Upload to save the settings in the sensor.
9. Push OK to save any changes, or push Cancel to close the window with no changes.
10. Go to the UCI menu at the top of the software window and select Exit (Ctrl-e).
11. Exit the software:

• Push No to close the software.
Turn off the sensor, remove from the power supply and attach the protective
dummy connector and lock collar.

• Push Yes to close the software and start the sensor. The sensor will collect data
immediately if the user selected "Continuous" or "Fixed-time" or at the user-
specified time if "Periodic" was selected.

2.5.2 Set up for SDI-12 deployment
Note: SDI-12 operation is not available on sensors rated to 2000 m.

SUNA operation
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The user can deploy the standard-depth sensor in a logger-controlled mode with an
SDI-12 controller.

1. Set up the sensor in SDI-12 mode to operate with a controller.
2. Make sure that the sensor is connected to and in communication with the software.
3. Push SUNA Settings in the SUNA Dashboard.
4. At the General tab, select the "SDI 12 Operational Mode."

5. If necessary, change the "Number of Measurements per Frame."
The sensor calculates the average of the value entered. For example, if "5" is
entered, 5 measurements will be averaged and will show as one measurement in the
data.

6. If the sensor is so equipped, put a check in the "Integrated Wiper Enabled" box.
The wiper operates before each measurement.

7. The default "Logging Level" is INFO.
8. Push Upload.

A new window shows.
9. Push Yes to put the SUNA into SDI-12 mode.

The sensor is ready to connect to an SDI-12 data logger.

SUNA operation
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Section 3 HydroCAT operation

Make sure that the sensor has new batteries installed or is connected to a power supply
(optional) or SDI-12 controller, and PC through the RS232 connector on the supplied
cable, and is on.
Most PCs no longer have RS232 "COM" ports so an RS232-to-USB converter is
necessary. Make sure that the USB driver software is installed on the PC so that there is
communication between the sensor and the PC.

3.1 Verify sensor operation
Do the steps below to make sure that the sensor operates, collects, and transfers data
with the settings selected by the user before further setup and deployment.

1. Connect the connectors on the cable to the bulkhead connector on the sensor and to
the PC.

2. If necessary, start the software.
3. Push Connect in the Dashboard area.
4. If necessary, change the "Sensor Type" to the connected sensor.
5. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
6. If necessary, select the communication port.
7. Push Connect.

The "Connection Mode" shows "Transition" on a yellow background, and then shows
"Setup" on a green background.

8. Select the UCI menu, then Preferences.
9. Go to the General tab and push Browse to find or make the Default Data Directory

on the PC.
Data from the sensor is saved here.

10. Push OK.

3.1.1 HydroCAT: set up output format
The parameters selected in this tab changes the data that is moved to the PC and the
data that shows in the Real Time Display tab. Parameters that are not selected are still
collected as data by the sensor but do not show in the Real Time Display tab or in the
data that is moved to the PC.

1. Push Apply to change the settings in the software.

3.1.2 HydroCAT: set up data collection
Select the Data tab to set the interval at which the sensor collects data.

1. Select the Data tab to set the interval between samples.
The sensor collects data at the end of the specified interval.

2. Enter a value between 10–21600 seconds in the "Sample Interval" area.
3. Put a check in the box so that the data collected during a deployment is sent to a

controller or logger and the user can see the data in real time.
The software enables the "Transmit Real Time" setting whether or not there is a
check in the box. The data shows in real time while the sensor is connected to the
software.
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3.1.3 HydroCAT: set up pump operation
Select the Pumping tab to set the values for the operation of the pump.

1. Find the "INST FREQ" (zero conductivity) value from the first row on the calibration
page supplied by the manufacturer.

2. Enter the Minimum Conductivity Frequency value. This is the Zero Conductivity
Frequency plus the offset value for either salt water (500 Hz) or fresh water (1 Hz).
This sum is the minimum conductivity frequency at which the pump will operate.

3. Select the "Start Date."
4. Select the "Start Time" (hours).
5. Push Apply.

3.1.4 Set up baud rate
It is not necessary to change the baud rate for deployment, but the user can set a faster
baud rate to transfer data after a deployment.
Available baud rates:

• 4800 
• 9600 
• 19200 HydroCAT, HydroCAT-EP default
• 38400 
• 57600 SUNA default
• 115200 

3.2 Verify sensor collects data
1. Push Start in the Dashboard area.

The "Connection Mode" shows "Acquisition."

• Push OK so that the software is "Temporarily enabling Transmit Real Time
Setting..." The software shows the data as it is collected in the Time Series tab.

• The Expected Data Start window shows "You will see data in approximately
103 seconds" and shows an indication of time left. This lets the sensor become
stable before it starts to collect data.

2. Push Select Sensors in the Time Series graph.

HydroCAT operation
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3. Put a check in the box next to any additional parameters, so that they will show in the
Time Series graph.

4. Optional: save data directly to the PC.

a. Go to the View menu and select Data Logging.
b. Push "Logging Options" to see details in this tab.
c. Push Browse to change the directory to which data is saved on the PC.
d. Push Start Logging to File.

5. Look at the data in the Time Series graph. The user can look at data in real-time for
each sensor that has power supplied, is connected and is in communication with the
software.

• Put a check in the box next to "Time Axis" to push Zoom In and Zoom Out to
change the scale of time.

• Put a check in the box next to "Range Axis" to push Zoom In and Zoom Out to
change the scale of the data.

• To move the data in any direction, push the "Ctrl" key on the PC keyboard and
the left button of the mouse pointer at the same time.

• To select a specific part of the data to zoom in on, pull the mouse pointer
diagonally (refer to the arrow in the graph below).

• Push Auto Range to see the data for each selected parameter. The software
adjusts the scale so that the data will always show.

• Push Default Ranges to go back to the manufacturer-set default scale for each
parameter.

• Put a check in the box next to "Show Data Points" to see the value of the
collected data when the mouse moves over each point.

• Push Select Sensors To Display to change the parameters to look at in the
Time Series graph.

6. Let the sensor collect data for approximately 5 minutes.
7. Push Stop in the Dashboard.

The "Connection Mode" mode shows "Setup."

HydroCAT operation
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3.3 Verify sensor transfers data

C A U T I O N
 

Use only the batteries recommended by the manufacturer as replacements. Do not mix new and
used cells or chemistries.

N O T I C E
 

Make sure that the sensor is connected to a power supply or has good batteries installed and is in
communication with the software.

1. Push Transfer Data in the Dashboard area.
The Transfer Data window shows.

• The Memory Summary lets the user estimate the available data storage in the
sensor. The "Sample Length" is sensor-specific and shows the length of each
data record that the sensor stores. Divide the "Free Samples" by "Sample
Length" for an estimate of how many samples the sensor can store.

2. In the "Transfer Type" drop-down menu in the Data Transfer Options area, select
either "All Data" or "Scan Number Range."

• "All Data": all data stored in the sensor is transferred to the PC in both .csv
and .xml file types.

• "Scan Number Range": a user-specified range of samples is transferred. Select
the specific samples in the Scan Range area. Note that the "Number Scans"
value is the total number of samples stored in the sensor.

3. In the Output CSV Data File area, type a new filename or use the automatically
generated file name.

4. Optional: change the time stamp to UTC.
5. Push Transfer to move the data to the PC.
6. Push OK when the Transfer Progress window shows 100%.
7. The default is a check in the box for "Display Data when Transfer Completed."

The user can remove the check so that data does not show in the Time Series tab
after it is saved to the PC.

8. The sensor is ready to set up for a specific deployment.

HydroCAT operation
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3.4 Verify precision of sensor output
To make sure that the sensor operates at optimum precision, the user must do various
checks and updates to the sensor at regular intervals.

3.4.1 Temperature check
Use a sensor that has the same or better specification for accuracy of the HydroCATs as
a reference to validate the temperature stability. The manufacturer recommends that the
user does this check in a laboratory because the temperature of the water in the
temperature check bath must be stable. Pass criteria:

• data is within 0.2 °C of the reference sensor
• three data points are within 0.01 °C.

1. Put the sensor in a temperature-stable water bath as close as possible to the sensor
that is being used as a reference.

2. Let the sensors become stable for at least one hour, or more if there is a large
difference between the water and the room temperature. Make sure that the
temperature of the reference sensor is stable to within 0.05–0.1 °C.

3. Record the temperature of the water in which the sensor is submerged.
4. Push Temperature Check in the Dashboard area.
5. Push Next to start the check.
6. Enter the water temperature in °C in the "Temperature" area.
7. Push Start.

The software takes a few minutes to collect data for the test. The results show in the
"Status" area.

8. Push Next.
9. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" to save only the new optics

check information.
10. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
11. Push Finish.
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The Temperature Check window closes and the .pdf report shows if the "View" box
has a check in it.

3.4.2 Conductivity checks
The software lets the user do a check of the accuracy of the conductivity measurements
made by the HydroCAT and the HydroCAT-EP. This shows that the conductivity cell
operates within specifications. There are two conductivity checks:

1. Zero conductivity

N O T I C E
 

Do not blow canned air into the intake or exhaust ports to dry the conductivity cells. It causes
damage to the cells.

Make sure that the conductivity cell is clean and dry, then start the check.

• For the HydroCAT-EP, this value is stored in the sensor.
• For the HydroCAT, this value is on the manufacturer-supplied calibration page.

Pass criterion for sensor: 0.3 Hz of calibrated conductivity.
2. Conductivity of a user-supplied conductivity standard solution.

• Use enough solution to completely fill the flow path of the sensor.
• Do this check after the solution and the sensor are at ambient temperature.

Pass criterion for sensor: 0.02 mS/cm of standard solution.

3.4.2.1 Zero conductivity check
The conductivity cell must be clean and dry to do the zero conductivity check. Refer to 
Clean sensor flow path for step-by-step instructions.

1. Remove the pH sensor if the flow path will be dry for more than 2 hours so that the
sensor does not dry out. Refer to Maintain pH sensor for details.

2. Push Conductivity Check in the Dashboard area.
3. Push Next to start the check.
4. At step 2, "Calibration Zero Conductivity Frequency Check":

• HydroCAT—enter the first value form the "INST FREQ" column on the
manufacturer-supplied calibration page.

• HydroCAT-EP—the software automatically enters this value from the sensor.
5. Push Start.

HydroCAT operation

22



The software takes a few minutes to collect data for the test. The results show "Check
Complete" in the "Status" area when the test is complete. If the conductivity value is
within 1.0 Hz of the calibrated zero conductivity, the sensor passes.

• If the sensor fails the conductivity check, refer to the hardware manual for details
on how to flush the flow path with Triton X-100™ solution and then rinse with DI
water. It may be necessary to flush the sensor several times.

• Make sure that the conductivity cell is clean and dry, then push Start to do the
conductivity check again.

6. Push Next.
The software shows the steps to complete the check for the user-supplied
conductivity standard.

7. Push Next.
The software is ready to do the check of the sensor with the conductivity standard
solution.

3.4.2.2 Conductivity standard calibration
The manufacturer recommends that the sensor is calibrated before and after a
deployment or when the sensor has been in contaminated water.
Make sure that the sensor and the solution(s) are at the same stable temperature.
Supplies necessary to do calibration:

• The manufacturer-supplied kit (P/N 50087.1) that has the necessary plumbing and
tools.

• 60 ml each of user-supplied conductivity standard solutions for calibration.
• 500 ml bottle of DI water
• Container for the sensor
• Container for waste water

Make sure that the output values of the sensor agree with a user-specified standard
solution.

1. Remove the anti-fouling devices from the sensor if necessary. Refer to Remove or
replace anti-fouling devices for details.

2. Flush the sensor with DI water.

a. Put the sensor in a container.
b. Attach a 10 cm length of tubing to either the intake or exhaust port of the sensor.
c. Attach a length of tubing to the syringe.
d. Pull approximately 30 ml of DI water into the syringe.
e. Attach the syringe and tubing to either the intake or the exhaust port of the

sensor.

HydroCAT operation

23



f. Push the syringe plunger to fill the sensor until 3–5 cm of solution shows in each
tube.

g. Push and pull the syringe plunger until there are no bubbles in the tubing.
h. Remove the sensor from the container and drain the fluid in the sensor into a

waste container. Push the syringe plunger to help remove all of the fluid from the
sensor.

i. Remove the tubing and shake the sensor.

The sensor is ready for a functional test in the laboratory, or for a deployment.
3. Flush the flow path of the sensor with the solution that will be used to test the output

of the sensor (steps A–H).
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4. Fill the flow path of the sensor with the conductivity standard solution (steps A–F).
5. Enter the value of the conductivity standard in step 4 of the Conductivity Check.
6. Push Start.

The software takes a few minutes to collect data for the "Standard Check" test. The
results show "Conductivity Check Passed" in the "Status" area.

• If the sensor fails the conductivity check, refer to Clean sensor flow paths for
details.

• When the flow path of the sensor has been flushed, fill with the appropriate
solution and push Start to do the conductivity check again.

7. Drain the solution in the flow path into a waste container.
8. To do another check with a different solution value:

a. Flush the sensor with DI water.
b. Flush the sensor with the next conductivity standard solution.
c. Fill the sensor with the next conductivity standard solution.

9. Push Next.
10. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" to save only the new optics

check information.
11. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
12. Push Finish.

The Conductivity Check window closes and the report opens if the "View" box has a
check in it.

13. Install the pH sensor again if the sensor will be deployed within an hour or two.
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3.5 Set up for deployment
1. Push Deployment Wizard in the Dashboard area.
2. Deployment Setup step 1: Select "Autonomous Sampling," or "Polled Sampling"

(SDI-12 or RS232).
3. Push Next.
4. Deployment Setup step 2: For "Autonomous Sampling": Set the date and time to

start data collection. Then push Next.
Put a check in the box next to "Transmit Real Time" to see the data as it is collected
in a terminal program or a data controller. If the user does not put a check in the box,
the sensor still collects and saves data, but it does not show the data in real time.

5. Deployment Setup step 3: For "Polled Sampling (SDI-12)": The manufacturer-set
default address is 0. Users can change this if necessary. Use the "Bad Data Flag"
default value of 9999999, then push Next.

6. Deployment Setup step 4: If necessary, change any of the settings in the Parameter
Units area and Parameters to Output.

7. Deployment Setup step 5: Enter the minimum conductivity frequency. Refer to the
section on Conductivity checks on page 22 for details on this value.

• Fresh water deployment—add a 1 Hz offset to the zero conductivity value of the
sensor.

• Salt water deployment—add a 500 Hz offset to the zero conductivity value of the
sensor.

8. Deployment Setup step 6: Put a check in the box to set the internal clock of the
sensor to the same time as the PC.

• Put a check in the box "Clear HydroCAT/EP data" to erase the data from the
internal memory of the sensor.

• If necessary, enter a pressure offset. If the sensor is deployed at sea level, enter
0.0 in the "Pressure Offset" area. The range is from -3402823 to 3402823.

9. Deployment Setup step 7: Enter the approximate minimum temperature of the water
in which the sensor will be deployed.

• Enter the approximate depth of water in which the sensor will be deployed.
• Enter the time interval between each sample for either autonomous or logger-

controlled (polled) operation.

• Range for HydroCAT: 10–21600 seconds
• Range for HydroCAT-EP: 75–21600 seconds

The calculated battery capacity and the number of 24-hour periods that the sensor
can operate is given as a reference. Note: The software calculates "Battery
Endurance" for new batteries only. Deployment time decreases for used batteries.

10. Push Next.
11. Deployment Setup step 8 (optional): make a Deployment Report.

• Enter the "Operator Name."
• Enter any text in the "Comments" area.
• Push Browse to change the location at which the report is saved on the PC.
• Put a check in the box next to "Overwrite if Existing" to save the new report only.

12. Push Finish. The sensor disconnects from the software.

• If the sensor was set up in a logger-controlled or "polled" mode, use the controller
unit to control the collection of data.
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• If the sensor was set up in an autonomous mode and there is a check in the
"Transmit in Real Time" box from Step 2 of the Deployment Setup, start a
terminal program to monitor data in real time.

13. When the deployment is complete, the user can connect to the software again and
push Transfer Data in the Dashboard to move the data that is saved in the sensor to
the PC.
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Section 4 HydroCAT-EP operation

Make sure that the sensor has new batteries installed or is connected to a power supply
(optional) or SDI-12 controller, and PC through the RS232 connector on the supplied
cable, and is on.
Most PCs no longer have RS232 "COM" ports so an RS232-to-USB converter is
necessary. Make sure that the USB driver software is installed on the PC so that there is
communication between the sensor and the PC.

4.1 Verify sensor operation
Do the steps below to make sure that the sensor operates, collects, and transfers data
with the settings selected by the user before further setup and deployment.

1. Connect the connectors on the cable to the bulkhead connector on the sensor and to
the PC.

2. If necessary, start the software.
3. Push Connect in the Dashboard area.
4. If necessary, change the "Sensor Type" to the connected sensor.
5. Put a check in the "Try All Baud Rates" box.

The software automatically finds the correct baud rate.
6. If necessary, select the communication port.
7. Push Connect.

The "Connection Mode" shows "Transition" on a yellow background, and then shows
"Setup" on a green background.

8. Select the UCI menu, then Preferences.
9. Go to the General tab and push Browse to find or make the Default Data Directory

on the PC.
Data from the sensor is saved here.

10. Push OK.

4.1.1 Set up output
The parameters selected in this tab change the data that is moved to the PC and the data
that shows in the Real Time Display tab. Parameters that are not selected are still
collected as data by the sensor but do not show in the Real Time Display tab or in the
data that is moved to the PC.

1. Push Settings in the Dashboard area of the connected sensor.
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2. If necessary, change any of the Parameter Units, or push Default to use the
manufacturer-set values.

Table 1  Parameter units

Temperature Celsius*, Fahrenheit

Conductivity uS/cm*, S/m mS/cm

Pressure Decibar*, PSI

Oxygen mg/L*, ml/L

* default parameter
3. If necessary, change any of the Parameters to Output, or push Default to use the

manufacturer-set values. Note that pH, chlorophyll, turbidity, and oxygen saturation
are specific to the HydroCAT-EP.
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Table 2  Parameters to output

Temperature* Salinity

Conductivity Sound velocity

Pressure* Specific conductivity*

Oxygen* Sample number

* default parameter
4. Push Apply to change the settings in the software.

4.1.2 Set up data collection

1. Select the Data tab to set the interval between samples.
The sensor collects data at the end of the specified interval.

2. Enter a value between 77–21600 seconds in the "Sample Interval" area.
3. Put a check in the box so that the data collected during a deployment is sent to a

controller or logger and the user can see the data in real time.
The software enables the "Transmit Real Time" setting whether or not there is a
check in the box. The data shows in real time while the sensor is connected to the
software.

4.1.3 Set up pump operation
Select the Pumping tab to set the values for the operation of the pump. The software
automatically gets the Zero Conductivity Frequency and the Minimum Conductivity
Frequency values from the connected sensor and shows them in the Pumping tab. The
Minimum Conductivity Frequency value is the Zero Conductivity Frequency plus the offset
value for either salt water (500 Hz) or fresh water (1 Hz). This sum is the minimum
conductivity frequency at which the pump will operate.

1. If necessary, change the "Minimum Conductivity Frequency."

• If the sensor is set up to operate in an autonomous mode, the pump will operate
a "pre-flush" for a manufacturer-set default of 300 seconds before data is
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collected. This removes air from the plumbing and primes the pump. The user
can enter a value from 300–600 seconds for the "Pre-flush Duration."

• If the sensor is set up to operate with a controller ("polled" mode), put a check in
the box next to " Scheduled Pre-flush for Polled Sampling." Make sure to set the
pre-flush cycle to complete before the sensor starts to collect data. Data
collection will cancel the pre-flush operation.

2. Select the "Start Date."
3. Select the "Start Time" (hours).
4. Push Apply.

4.1.4 Set up baud rate
It is not necessary to change the baud rate for deployment, but the user can set a faster
baud rate to transfer data after a deployment.
Available baud rates:

• 4800 
• 9600 
• 19200 HydroCAT, HydroCAT-EP default
• 38400 
• 57600 SUNA default
• 115200 

4.2 Verify sensor collects data
1. Push Start in the Dashboard area.

The "Connection Mode" shows "Acquisition."

• Push OK so that the software is "Temporarily enabling Transmit Real Time
Setting..." The software shows the data as it is collected in the Time Series tab.

• The Expected Data Start window shows "You will see data in approximately
103 seconds" and shows an indication of time left. This lets the sensor become
stable before it starts to collect data.

2. Push Select Sensors in the Time Series graph.
3. Put a check in the box next to any additional parameters, so that they will show in the

Time Series graph.
4. Optional: save data directly to the PC.

a. Go to the View menu and select Data Logging.
b. Push "Logging Options" to see details in this tab.
c. Push Browse to change the directory to which data is saved on the PC.
d. Push Start Logging to File.
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5. Look at the data in the Time Series graph. The user can look at data in real-time for
each sensor that has power supplied, is connected and is in communication with the
software.

• Put a check in the box next to "Time Axis" to push Zoom In and Zoom Out to
change the scale of time.

• Put a check in the box next to "Range Axis" to push Zoom In and Zoom Out to
change the scale of the data.

• To move the data in any direction, push the "Ctrl" key on the PC keyboard and
the left button of the mouse pointer at the same time.

• To select a specific part of the data to zoom in on, pull the mouse pointer
diagonally (refer to the arrow in the graph below).

• Push Auto Range to see the data for each selected parameter. The software
adjusts the scale so that the data will always show.

• Push Default Ranges to go back to the manufacturer-set default scale for each
parameter.

• Put a check in the box next to "Show Data Points" to see the value of the
collected data when the mouse moves over each point.

• Push Select Sensors To Display to change the parameters to look at in the
Time Series graph.

6. Let the sensor collect data for approximately 5 minutes.
7. Push Stop in the Dashboard.

The "Connection Mode" mode shows "Setup."

4.3 Verify sensor transfers data

C A U T I O N
 

Use only the batteries recommended by the manufacturer as replacements. Do not mix new and
used cells or chemistries.

N O T I C E
 

Make sure that the sensor is connected to a power supply or has good batteries installed and is in
communication with the software.

1. Push Transfer Data in the Dashboard area.
The Transfer Data window shows.

• The Memory Summary lets the user estimate the available data storage in the
sensor. The "Sample Length" is sensor-specific and shows the length of each
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data record that the sensor stores. Divide the "Free Samples" by "Sample
Length" for an estimate of how many samples the sensor can store.

2. In the "Transfer Type" drop-down menu in the Data Transfer Options area, select
either "All Data" or "Scan Number Range."

• "All Data": all data stored in the sensor is transferred to the PC in both .csv
and .xml file types.

• "Scan Number Range": a user-specified range of samples is transferred. Select
the specific samples in the Scan Range area. Note that the "Number Scans"
value is the total number of samples stored in the sensor.

3. In the Output CSV Data File area, type a new filename or use the automatically
generated file name.

4. Optional: change the time stamp to UTC.
5. Push Transfer to move the data to the PC.
6. Push OK when the Transfer Progress window shows 100%.
7. The default is a check in the box for "Display Data when Transfer Completed."

The user can remove the check so that data does not show in the Time Series tab
after it is saved to the PC.

8. The sensor is ready to set up for a specific deployment.

4.4 Verify precision of sensor output
To make sure that the sensor operates at optimum precision, the user must do various
checks and updates to the sensor at regular intervals.

4.4.1 Temperature check
Use a sensor that has the same or better specification for accuracy of the HydroCATs as
a reference to validate the temperature stability. The manufacturer recommends that the
user does this check in a laboratory because the temperature of the water in the
temperature check bath must be stable. Pass criteria:

• data is within 0.2 °C of the reference sensor
• three data points are within 0.01 °C.
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1. Put the sensor in a temperature-stable water bath as close as possible to the sensor
that is being used as a reference.

2. Let the sensors become stable for at least one hour, or more if there is a large
difference between the water and the room temperature. Make sure that the
temperature of the reference sensor is stable to within 0.05–0.1 °C.

3. Record the temperature of the water in which the sensor is submerged.
4. Push Temperature Check in the Dashboard area.
5. Push Next to start the check.
6. Enter the water temperature in °C in the "Temperature" area.
7. Push Start.

The software takes a few minutes to collect data for the test. The results show in the
"Status" area.

8. Push Next.
9. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" to save only the new optics

check information.
10. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
11. Push Finish.

The Temperature Check window closes and the .pdf report shows if the "View" box
has a check in it.

4.4.2 Conductivity checks
The software lets the user do a check of the accuracy of the conductivity measurements
made by the HydroCAT and the HydroCAT-EP. This shows that the conductivity cell
operates within specifications. There are two conductivity checks:
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1. Zero conductivity

N O T I C E
 

Do not blow canned air into the intake or exhaust ports to dry the conductivity cells. It causes
damage to the cells.

Make sure that the conductivity cell is clean and dry, then start the check.

• For the HydroCAT-EP, this value is stored in the sensor.
• For the HydroCAT, this value is on the manufacturer-supplied calibration page.

Pass criterion for sensor: 0.3 Hz of calibrated conductivity.
2. Conductivity of a user-supplied conductivity standard solution.

• Use enough solution to completely fill the flow path of the sensor.
• Do this check after the solution and the sensor are at ambient temperature.

Pass criterion for sensor: 0.02 mS/cm of standard solution.

4.4.2.1 Zero conductivity check
The conductivity cell must be clean and dry to do the zero conductivity check. Refer to 
Clean sensor flow path for step-by-step instructions.

1. Remove the pH sensor if the flow path will be dry for more than 2 hours so that the
sensor does not dry out. Refer to Maintain pH sensor for details.

2. Push Conductivity Check in the Dashboard area.
3. Push Next to start the check.
4. At step 2, "Calibration Zero Conductivity Frequency Check":

• HydroCAT—enter the first value form the "INST FREQ" column on the
manufacturer-supplied calibration page.

• HydroCAT-EP—the software automatically enters this value from the sensor.
5. Push Start.

The software takes a few minutes to collect data for the test. The results show "Check
Complete" in the "Status" area when the test is complete. If the conductivity value is
within 1.0 Hz of the calibrated zero conductivity, the sensor passes.

• If the sensor fails the conductivity check, refer to the hardware manual for details
on how to flush the flow path with Triton X-100™ solution and then rinse with DI
water. It may be necessary to flush the sensor several times.
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• Make sure that the conductivity cell is clean and dry, then push Start to do the
conductivity check again.

6. Push Next.
The software shows the steps to complete the check for the user-supplied
conductivity standard.

7. Push Next.
The software is ready to do the check of the sensor with the conductivity standard
solution.

4.4.2.2 Conductivity standard calibration
Make sure that the sensor and the solution(s) are at the same stable temperature.
Supplies necessary to do calibration:

• The manufacturer-supplied kit (P/N 50087.1) that includes the necessary plumbing
and tools.

• 60 ml each of user-supplied conductivity standard solutions for conductivity
calibration.

• 500 ml bottle of DI water.

• Container for waste water.

• Container for the sensor.

Make sure that the output values of the sensor agree with a user-specified standard
solution. The general procedure to do each calibration:

1. Flush the sensor and tubing with DI water.
2. Flush the sensor and tubing with the appropriate calibration solution.
3. Fill the sensor with the appropriate solution and operate the sensor with the software

to measure the output.
4. Do steps 1–3 for each solution.

• Remove the anti-fouling assembly: loosen the two captured 5/32" cap screws that
attach the anti-fouling assembly to the pressure housing.

4.4.2.2.1 Flush sensor with DI water

1. Put the sensor in a container.
2. Attach a 10 cm length of tubing to either the intake or the exhaust port of the sensor.
3. Attach a length of tubing to the syringe.
4. Pull approximately 30 ml of DI water into the syringe.
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5. Pull approximately 30 ml of cleaning solution into the syringe.

6. Attach the syringe and tubing to either the intake or the exhaust port of the sensor.
7. Push the syringe plunger to fill the sensor until 3–5 cm of solution shows in each

tube.
8. Push and pull the syringe plunger until there are no bubbles in the tubing.
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Note that in the photo above, the syringe is attached to the exhaust port and the
waste tubing is attached to the intake port.

9. Remove the sensor from the container and drain the fluid in the sensor into a waste
container.

10. Push the syringe plunger to help remove all of the fluid from the sensor.
11. Remove the tubing and shake the sensor.

The sensor is ready for a functional test in the laboratory or a deployment.
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4.4.2.2.2 Flush sensor with solution
Do the steps in Flush sensor with DI water on page 37 to flush the sensor with the
solution that will be used to test the output of the sensor.

4.4.2.2.3 Fill sensor with solution

1. Do steps 1–7 in Flush sensor with DI water on page 37 and fill the flow path of the
sensor with the conductivity standard solution.

2. Enter the value of the conductivity standard in step 4 of the Conductivity Check.
3. Push Start.

The software takes a few minutes to collect data for the "Standard Check" test. The
results show "Conductivity Check Passed" in the "Status" area.

• If the sensor fails the conductivity check, refer to the hardware manual for details
on how to flush the flow path with Triton X-100™ solution and then rinse with DI
water.

• When the sensor has been flushed, push Start to do the conductivity check
again.

4. To do another check with a different solution value:

a. Flush the sensor with DI water.
b. Flush the sensor with the next conductivity standard solution.
c. Fill the sensor with the next conductivity standard solution.

5. Push Next.
6. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" to save only the new optics

check information.
7. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
8. Push Finish.

The Conductivity Check window closes and the report opens if the "View" box has a
check in it.
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4.4.3 pH calibration

C A U T I O N
 

Wear latex gloves, a lab coat, and safety glasses. Wash hands after use.

Make sure that the pH values of the HydroCAT-EP agree to ±0.05 pH with the
manufacturer-supplied calibration values.
Supplies necessary to do the calibration:

• The manufacturer-supplied kit (P/N 50087.1) that includes the necessary plumbing
and tools.

• 60 ml each of colorless buffers for pH calibration.

• 500 ml bottle of DI water.

• Container for waste water.

• Container for the sensor.

Make sure that the sensor and the pH calibration buffers are at a stable temperature. The
general procedure for each calibration step:

1. Flush the sensor and tubing with DI water.
2. Flush the sensor and tubing with the appropriate calibration solution.
3. Fill the sensor with the appropriate solution and operate the sensor with the software

to measure the output.
4. Do steps 1–3 for each solution.

Refer to Conductivity standard calibration on page 23 for procedure to flush and fill the
sensor flow path.

4.4.3.1 Flush sensor with DI water

1. Put the sensor in a container.
2. Attach a 10 cm length of tubing to either the intake or the exhaust port of the sensor.
3. Attach a length of tubing to the syringe.
4. Pull approximately 30 ml of DI water into the syringe.
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5. Pull approximately 30 ml of cleaning solution into the syringe.

6. Attach the syringe and tubing to either the intake or the exhaust port of the sensor.
7. Push the syringe plunger to fill the sensor until 3–5 cm of solution shows in each

tube.
8. Push and pull the syringe plunger until there are no bubbles in the tubing.
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Note that in the photo above, the syringe is attached to the exhaust port and the
waste tubing is attached to the intake port.

9. Remove the sensor from the container and drain the fluid in the sensor into a waste
container.

10. Push the syringe plunger to help remove all of the fluid from the sensor.
11. Remove the tubing and shake the sensor.

The sensor is ready for a functional test in the laboratory or a deployment.
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4.4.3.2 Flush sensor with solution
Do the steps in Flush sensor with DI water on page 37 to flush the sensor with the
solution that will be used to test the output of the sensor.

4.4.3.3 pH calibration with solutions

1. Use the pH 4 solution to do the steps in Flush sensor with DI water on page 37 to
flush the flow path of the sensor.

2. Use the pH 4 solution to do steps 1–7 in Flush sensor with DI water on page 37 to fill
the flow path of the sensor.

3. Push pH Calibration in the Dashboard area.
4. Push Next.
5. Push Start.

The software takes a few minutes to collect data for the pH buffer solution. The
results show in the "Status" area when the test is complete.

1. If the sensor completes the calibration check, go to the next step.
2. If the sensor fails:

• Make sure that the pH probe is clean and wet, either from the flow path or the
storage cap. Do the steps below to make sure that the probe is ready for
deployment.

Refer to the hardware user's guide for details about maintenance and
troubleshooting of the pH probe.

• Flush the sensor with DI water again, then push Repeat to do this step again.
6. Push Next.
7. Do the steps in Flush sensor with DI water on page 37 with DI water to make sure

that the pH 4 solution is flushed from the sensor.
8. Use the pH 7 solution to do the steps in Flush sensor with DI water on page 37 to

flush the flow path of the sensor.
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9. Use the pH 7 solution to do steps 1–7 in Flush sensor with DI water on page 37 to fill
the flow path of the sensor.

10. Push Start.
The progress bar shows the "Status" of the check at pH 7.

• If the sensor completes the calibration check, go to the next step.
• If the sensor fails, do step 5 above.

11. Push Next.
12. Do the steps in Flush sensor with DI water on page 37 with DI water to make sure

that the pH 7 solution is flushed from the sensor.
13. Use the pH 10 solution to do the steps in Flush sensor with DI water on page 37 to

flush the flow path of the sensor.
14. Use the pH 10 solution to do steps 1–7 in Flush sensor with DI water on page 37 to

fill the flow path of the sensor.
15. Push Start.

The progress bar shows the "Status" of the check at pH 10.

• If the sensor passes, go to the next step.
• If the sensor fails, do step 5 above.

16. Push Next.
The software makes a report in a .pdf format that is saved to the user-selected
location on the PC.

17. Push Finish.
The Calibration window closes and the report opens if the "View" box has a check in
it.

18. Do the steps in Flush sensor with DI water on page 37 with DI water to make sure
that the pH 10 solution is flushed from the sensor.

19. Attach the anti-fouling assembly to the sensor again.

4.4.4 Optics check
Users that have the optional check cap can do the steps below to make sure that the
optical values of the HydroCAT-EP agree to within 20% of the manufacturer-supplied
calibration values of the sensor. Make sure that the temperature of the sensor is
18–26 °C or the optics check is not valid.

1. If necessary, remove the red protective cap from the optical face of the sensor so that
the optional check cap can be attached.

2. Make sure that the inside of the check cap is shiny, clean and dry and attached to the
optical face of the sensor. Refer to Maintain optics for details about the maintenance
of the optical face and the check cap.

3. To "pair" a new check cap with the optics:
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1. go to the Sensor menu, then HydroCAT-EP, Advanced, then Pair Optics Cal
Cap.

2. Enter the serial number of the new calibration cap, then push OK. The software
updates the reference values in the sensor.

3. Push OK to finish.
4. Do the steps below to do a check with a currently owned optical check cap.
5. Push Optics Check in the Dashboard area.
6. Push Next.
7. Push Start.

The software looks at the calibration values saved in the sensor. This will take
approximately 2 minutes.

8. If the sensor passes the optics check, go to step 10.
9. If the sensor fails the optics check:

• Make sure that the calibration cap is straight on the optical face and that the
index pin on the cap is in the notch on the sensor.

• Clean the optical face of the sensor and the orange glass of the cap.
• Do the optical check again.

10. Push Next.
11. Push Next.

The Create Optics Check Report window shows.
12. The user can choose to make a report.

• Enter any text in the "Notes" area.
• Push Browse to change the location where the report is saved on the PC.
• Change the "Report File Name."
• Put a check in the "View" box so that the report automatically opens when it is

completed.
• Put a check in the "Overwrite file if it already exists" to save only the new optics

check information.
13. Push Next.

The software saves a .pdf report in the user-specified location on the PC.
14. Push Finish.

The window closes and the report opens if the "View" box has a check in it.

4.5 Set up for deployment
1. Push Deployment Wizard in the Dashboard area.
2. Deployment Setup step 1: Select "Autonomous Sampling," or "Polled Sampling"

(SDI-12 or RS232).
3. Push Next.
4. Deployment Setup step 2: For "Autonomous Sampling": Set the date and time to

start data collection. Then push Next.
Put a check in the box next to "Transmit Real Time" to see the data as it is collected
in a terminal program or a data controller. If the user does not put a check in the box,
the sensor still collects and saves data, but it does not show the data in real time.

5. Deployment Setup step 3: For "Polled Sampling (SDI-12)": The manufacturer-set
default address is 0. Users can change this if necessary. Use the "Bad Data Flag"
default value of 9999999, then push Next.

6. Deployment Setup step 4: If necessary, change any of the settings in the Parameter
Units area and Parameters to Output.
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7. Deployment Setup step 5: Enter the minimum conductivity frequency. Refer to the
section on Conductivity checks on page 22 for details on this value.

• Fresh water deployment—add a 1 Hz offset to the zero conductivity value of the
sensor.

• Salt water deployment—add a 500 Hz offset to the zero conductivity value of the
sensor.

8. Deployment Setup step 6: Put a check in the box to set the internal clock of the
sensor to the same time as the PC.

• Put a check in the box "Clear HydroCAT/EP data" to erase the data from the
internal memory of the sensor.

• If necessary, enter a pressure offset. If the sensor is deployed at sea level, enter
0.0 in the "Pressure Offset" area. The range is from -3402823 to 3402823.

9. Deployment Setup step 7: Enter the approximate minimum temperature of the water
in which the sensor will be deployed.

• Enter the approximate depth of water in which the sensor will be deployed.
• Enter the time interval between each sample for either autonomous or logger-

controlled (polled) operation.

• Range for HydroCAT: 10–21600 seconds
• Range for HydroCAT-EP: 75–21600 seconds

The calculated battery capacity and the number of 24-hour periods that the sensor
can operate is given as a reference. Note: The software calculates "Battery
Endurance" for new batteries only. Deployment time decreases for used batteries.

10. Push Next.
11. Deployment Setup step 8 (optional): make a Deployment Report.

• Enter the "Operator Name."
• Enter any text in the "Comments" area.
• Push Browse to change the location at which the report is saved on the PC.
• Put a check in the box next to "Overwrite if Existing" to save the new report only.

12. Push Finish. The sensor disconnects from the software.

• If the sensor was set up in a logger-controlled or "polled" mode, use the controller
unit to control the collection of data.

• If the sensor was set up in an autonomous mode and there is a check in the
"Transmit in Real Time" box from Step 2 of the Deployment Setup, start a
terminal program to monitor data in real time.

13. When the deployment is complete, the user can connect to the software again and
push Transfer Data in the Dashboard to move the data that is saved in the sensor to
the PC.
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Section 5 Reference

5.1 Sensor dashboards
The dashboard is the main area from which to control and to communicate with the
sensor.
Information about the status of the sensor is contained in the upper part of the window
and is updated each time the sensor is connected to the software.
Common settings

• Start/Stop lets the user start and stop data collection.
• Sensor Settings lets the user select options for a specific deployment.
• Deployment Wizard lets the user select a deployment mode, start time, and the

parameters to measure, estimate the deployment time and data collection interval,
and make a summary report of the status of the sensor.

• Transfer Files, Data lets the user move data saved on the sensor to a PC.
• Replay Logged Data lets the user see data that was saved on a PC in a graph.
• Command Terminal lets the user send terminal program-level commands to the

sensor.
• Select Sensors lets the user select the parameters that show in the Time Series

graph.

Sensor-specific settings

• SUNA: Reference Update lets the user update the reference spectrum stored in the
sensor so that the sensor can accurately convert a spectral measurement into nitrate
concentration.

• SUNA: Wipe Now lets the user operate the anti-fouling wiper for one revolution.

• HydroCAT, HydroCAT-EP: Start Pumping operates the pump for 5 minutes if the
sensor is in water.

• HydroCAT, HydroCAT-EP: Conductivity Check lets the user verify that the
conductivity value that is output by the sensor is within specification.

• HydroCAT, HydroCAT-EP: Temperature Check lets the user enter reference
temperatures, collect data, and make new reference values..

• HydroCAT-EP: Optics Check lets the user verify that the optics values are within
specification.

• HydroCAT-EP: pH Calibration lets the user verify that the pH value is within
specification.

5.2 UCI menu
The user can set up the way the that the software saves information about the operation
of the sensor and change the way that the data looks from the Preferences menu.

5.2.1 General tab
• "Maximum Wakeup Attempts" lets the user select the number of times the software

will try to connect to a sensor. Range: 5–15.
• "Response Timeout" is the interval of time between communication between the

sensor and the software. Range: 5–10.
• "Default Data Directory" lets the user enter the location on the PC in which to save

data from the sensor. If there is a check in the "Prompt at startup" box, the user can
change the directory that the data is stored in every time the software starts.
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5.2.2 Display tab
Note: The software operates faster if the user selects less data and only one or two graphs.

Data that is collected by the sensor shows in the user-selected graphs in the
Performance Optimization Settings area of the Display tab.

• RS232 only: "Enable Real Time Display"—Put a check in this box to see the data as
it is collected in either the software, or if deployed, a terminal program.

• "Enable Time Series Graph"—Put a check in this box to see user-selected data.
Remove the check in the box to so that the graph is disabled and the data does not
show.

• SUNA only: "Enable Spectra Graph"—Put a check in this box to see both dark and
light data in raw counts. Refer to Monitor data in spectra graph on page 8for details.

• SUNA only: "Enable Total Absorbance Graph"—Put a check in this box to see the
calculated absorbance. Refer to Monitor data in absorbance graph on page 8 for
details.

Time Series Settings—The default is a check in the box for continuous data collection
that is not limited to a specified amount of time. Remove the check in the box to enable
the "Time Axis Range Limit" of 60 minutes (default value). Only the most recent hour of
data will show in the Time Series Graph. The user-selectable range is 1–1440 minutes.

5.2.3 Message logging tab
The software automatically saves files that have information about sensor use, data
collection, and software operation over time. This information helps the user and
Customer Support find problems and do troubleshooting.
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When the "Display Dialog for Error Level Messages" box has a check in it, the software
saves one of five levels of error messages.

• INFO—The default level. All high-level operations are saved.
• ERROR—Minimum level. Only errors that need to be examined by the user or

Customer Support are saved.
• WARN—Low level. The files that are saved do not have enough information for the

user to make an analysis of how the sensor is used and set up.
• DEBUG—High level. Used for troubleshooting. DEBUG and TRACE files are very

large.
• TRACE—The highest level. Used only for troubleshooting.

"Daily Log Files"—all messages from a single day are saved in one file.
"Rolling Log Files"—all messages are saved in one file until it is the maximum size
specified by the user. The messages are then saved to a new file. The user specifies the
number of files to keep. The oldest files are erased first.
"Enable Logging Lost Bytes"—if this box has a check in it, the software saves all of the
unexpected output from the sensor to a file.
"File Location"—the operating system of the PC determines where these files are saved.

5.3 Sensor menu
The Sensor menus have options for each sensor with which the software communicates.
Refer to the section on Sensor dashboards on page 49 for more information about these
items.
Advanced Sensor menu items

• All: Set Clock lets the user "synchronize" the time between the PC and the sensor.

• SUNA: Edit Log Headers lets the user put labels on log files.
• SUNA: SUNA Self Test—the software does a test of the sensor function. The output

shows in the Instrument Console tab.
• SUNA: DAC Calibration does not apply to coastal deployments.
• SUNA: Upload Firmware File lets the user update the firmware in the sensor. Refer

to the section on Update firmware on page 12 for details.
• SUNA: Administrative Settings is used only by the manufacturer.
• SUNA: Upload Instrument XML File is an .xml file necessary for the sensor to

process data.
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• HydroCAT: Pressure Offset lets the user enter a value for the pressure offset of the
sensor. This value is also given the "Summary Report."

• HydroCAT-EP: Pair Optics Cal Cap lets the user enter the serial number of a new
check cap to connect, or "pair" it with the sensor.

• HydroCAT, HydroCAT-EP: Delete Logged Data lets the user erase all of the data
saved in the sensor.

5.3.1 Make summary report
Get a summary of the settings saved in the sensor.

1. Select Summary Report.

2. Enter any comments about the report (optional).
3. Put a check in the "View Report" checkbox to see the report after it is created.
4. Push Browse to go to the directory in which to save the report.
5. Push Save Report.

The software makes a .pdf of the summary report.

5.3.2 Collect diagnostics
Use the diagnostic results to look at the current settings and commands sent to the
sensor that are saved as .log files. They are helpful for troubleshooting.

1. Go to the Sensor menu, select the connected HydroCAT, then select Collect
Diagnostics.

2. If necessary, push Browse to change the location on the PC to which the .zip file is
saved.

3. Push OK.
The Diagnostics Created window shows. Push OK to close the window.

4. Go to the .zip file on the PC and extract the files. There are three folders:

• console contains a summary of the operation, calibration, and device
configurations, and the event counter saved in the sensor.

• event log contains .log files useful for troubleshooting.
• reports contains the summary report referred to in Make summary report

on page 52.

5.3.3 HydroCAT-EP update firmware
Update the firmware for the sensor in the software program as necessary. The most
recent version is available on the manufacturer's website.

1. Go to the Sensor menu, select HydroCAT-EP, select Advanced, then select Upgrade
Firmware.

2. A Select Firmware File window shows.
3. Select the file with the .txt suffix.
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4. Push Open.
5. The software updates the firmware in the sensor.

This process will take several minutes. When process is complete, the software will
show the version and build of the new firmware installed in the sensor.

6. Push OK.

5.4 Data menu
The Data menu has sensor-specific options to look at data that has been saved to a PC.

5.4.1 Replay saved data
Use Replay Logged Data to see the data that has been saved on the PC.

1. Push Data, then [sensor], then Replay Logged Data.
2. Push Browse to find the file to replay that is saved on the PC.
3. Push OK.

4. The saved data shows in the Time Series tab.

5.4.2 Options to process data
Go to the Data menu to select how data is processed.

• Use Reprocess Data to apply a different calibration or other setting to saved data.
• Use Replay Logged Data to show a graph of saved data.
• Use Convert Raw Data to change binary files into ASCII files.
• Use Convert APF Data to convert APF data from binary to full_ASCII so data can be

re-processed.
• Use Compare Calibration to compare two calibrations from the same sensor.

The SUNA uses the files below to process data:

• The .xml instrument package file. For Windows, this is C:\Users\%USERNAME\My
Documents\Sea-BirdScientific\SUNA. For Mac OS X, this is /Users/Home/Sea-
BirdScientific/SUNA.

• The raw data file to process.
• The calibration file for the sensor.

5.4.2.1 Reprocess SUNA data
The user may find that it helps to use the Reprocess Data option under some conditions.

• The settings for the sensor were incorrect. Use the "Reprocess" option to correct for
this, such as when a sensor was deployed in seawater, but set up for fresh water.

• The data that is collected has changed over an extended deployment. Data is
processed with an updated reference spectrum file, and compared to the original
reference.

• Water temperature and salinity data are collected. These can be put together with the
spectral data from the sensor to get more accurate nitrate data (Sakamoto et al.
2009).

Note that the data files collected with SDI-12 do not contain spectral data and cannot be
reprocessed.
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1. If necessary, start the software and supply power to the sensor.
2. Go to the Data menu, then select SUNA, then Reprocess Data.

The Reprocessing Dashboard shows.

3. Push Browse to find the package file, the reference file, and the data file required to
reprocess the data.

4. The user can change the "Output Directory" if necessary.
5. The reprocess operation will be faster if there is no check in the "Graph Results" box.
6. Push Process Selected File(s).

The software starts to reprocess the data.
7. Open the files on the PC.

5.4.2.2 Convert SUNA raw data
The user can collect data in either an ASCII or binary format. Although binary files require
less storage space and are faster to transmit than ASCII, binary files are not human-
readable and must be converted. Use the software to convert binary to ASCII, and also to
"convert" ASCII files so that they contain sensor headers, tab delimiters, and other
information to help the user more easily do an analysis on the data.

1. Go to the Data menu, then SUNA, then Convert Raw Data.
2. If necessary, push Browse to find the .xml "Instrument Package File" that is saved on

the PC. A typical file is "SUNA_xxx_001.xml, where xxx is the serial number of the
sensor.

3. Put a check in the boxes next to the parameters to convert.
4. Push Browse to find the file of data to convert.
5. Push Browse to select the directory in which to save the converted data.
6. Push Options. More settings are available in a new window.
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7. Select any options under Conversion Type:

• "Output Field Delimiter"—select either comma or tab delimiter.
• "Output Extra Header Information"—put a check to get an additional row of data

at the start of the output file.
• "Use Data Logger Time Stamps"—put a check to add data and time values from

an attached data logger. This is not usually necessary because the sensor
includes this information in its output.

• "Output Frame Time Stamps"—put a check to add the time stamps from the data
frame to the output.

• "Output Frames with Sensor Conversion Errors"—put a check to remove any
frames that have a field that cannot be converted.

• "Single Output File per Frame Definition"—put a check to get all of the output in
one file. Usually there is one output file for each input file.

8. Select options under Output Format:

• "Floating Point Conversion Type"—specify the floating point values in decimal or
scientific notation.

• "Floating Point Precision"—specify the number of significant digits in the floating
point value. Range: 0–10.

• "Suppress Non-numerical Output Values"—put a check so that text content does
not show in the output.

• "Format Frame Time Stamps"—put a check so that the time stamps print in
human-readable format.

• "Display Converted Data"—put a check so that the data shows in the graph area
of the software.

9. Select options under Error Checking:

• "Frame Counter (if available)"—put a check so that the value increases by one
from frame to frame. Any increments larger than one will show in the Application
Console.

• "Check Sum (if available)"—put a check so that each frame is examined. Correct
frames have a zero entry in the checksum field. Incorrect frames are not
converted.

10. Push OK. The Conversion Options window closes.
11. Push OK. The Convert Raw Data Files to ASCII window closes.

5.4.2.3 Replay saved SUNA data

Use Replay Logged Data to see the data that has been saved on the PC.

1. Push Data, then SUNA, then Replay Logged Data.
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2. If necessary, push Browse to find the .xml "Instrument Package File" that is saved on
the PC. A typical file is "SUNA_xxx_001.xml, where xxx is the serial number of the
sensor.

3. Push Browse to find the "SUNA Raw Data File" to replay the data that is saved on
the PC.

4. Push Browse to find the current "SUNA Calibration File" on the PC. A typical file is
SUNA_xxxn.CAL, where xxx is the serial number of the sensor, and n is the
calibration version.

5. Push Finish.

6. The saved data shows in the Time Series tab.

5.4.3 Compare reference spectrum files
Compare the change between two reference spectrum files. The amount of change is
related to the time interval between the updates and the amount of lamp use during that
time.
Note that this procedure is done automatically by the software when the user updates the
reference spectrum for the sensor. Refer to Update reference spectrum on page 9 for
more information.

1. Find the two files to compare:

a. Push Transfer Files in the SUNA Dashboard area.
b. Select the Calibration Files tab.
c. Select the first file under Instrument Filesystem.
d. Select the directory in the Local Filesystem in which to save the file.
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e. Push the <-- to move the first file.
f. Do steps d and e to move the second file.
g. Push Close.

Note that the date of the files changes to the current date.
2. Select the Data > SUNA > Compare Calibration menu.
3. Push Browse to find to the first reference, or calibration, file on the PC to compare.
4. Push Browse to find to the second reference, or calibration, file on the PC to

compare.
5. Push Compare.

A typical update interval of 3–6 months with no more than 100 hours of lamp use
should cause a change of no more than 10% in the 215–240 nm interval.
Below 215 nm, larger relative changes are normal.
Above 240 nm, the change is smaller than at the 215–240 nm range.
If there is a large change, do several reference updates 12–24 hours apart to monitor
the stability of the reference spectrum.

5.4.4 Replay data from multiple sensors
The software lets the user replay data that has been saved on the PC from each
supported sensor. The user can select up to 12 parameters to replay.

1. Go to the Data menu, then Replay Logged Data.
2. Go to the area of the first supported sensor and push Browse to go to the .csv file-

type.
3. Select the file, then push Open.
4. Push Select Sensors for Display.
5. Put a check in the box of each parameter to look at in the Time Series graph.
6. Push OK.
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5.5 View menu

Dashboards—Go to the View menu and Dashboards to select the dashboard for a
specific senor.
Graphs—Go to the View menu and select Time Series or SUNA > Spectra, Absorbance,
Reprocessed Nitrate. Refer to Verify sensor collects data on page 18 for details about the
Time Series graph.

• SUNA Spectra graph: the user can push Configure to change the number of graphs
to view. The "Graph History Limit" range is 1–2147483647. Put a check in the "Graph
History Unbounded" box to see the total number of graphs. Default value: no check in
the box and a "Graph History Limit" of 1.

• SUNA Absorbance graph: the user can change the "Min. Wavelength Cutoff" to
between 150–400 nm to change the scale of the graph. The user can push
Configure to change the number of graphs to view. The "Graph History Limit" range
is 1–2147483647. Put a check in the "Graph History Unbounded" box to see the total
number of graphs. Default value: no check in the box and a "Graph History Limit" of
1.

Output—Go to the View menu and select Instrument Console to see the data collected
by the sensor. Select Application Console to see terminal-level communications.
HydroCAT: select Post-processed Console.
Instrument Console

Application Console

Real Time Data—Go to the View menu and select Real Time Data to select the
parameters that the specific sensor will use for data collection.
Data Logging—Go to the View menu and select Data Logging to select the location on
the PC at which the collected data is saved.
Data Acquisition Monitor—Used by manufacturer for troubleshooting.
Message Log File—Used by manufacturer for troubleshooting.
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5.6 Window menu
The user can change how the software shows different tabs.

• Close Window—closes the selected tab (highlighted in blue).
• Close all Documents—closes all tabs except the UCI Dashboard.
• Configure Window—

Maximize: increases the size of the selected tab to fill the software screen size.
Float: unlocks the selected tab from the software screen so that the user can move it
to other locations on the PC screen.
Float Groups: the same as Float above, but all tabs that are open are unlocked so
that the user can move them to other locations on the PC screen.
Minimize: minimizes the selected tab and moves it to the side of the software screen.
Minimize Group: minimizes the open tabs in the "Console," "Dashboard," or "Graph"
areas of the software.
Dock: locks the tab that the user selected to "float" back to its previous position in the
software window.
Dock Group: the same as Dock above, but all tabs that are open are locked back into
their previous position in the software window.

• Reset Windows: all tabs go to their initial location in the software when the software
started.

5.7 Help menu
Go to the Help menu for help with sensor operation, settings in the software, and
troubleshooting. Select Sea-Bird Scientific to go to the manufacturer's web site.
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Section 6 Troubleshooting

6.1 SUNA troubleshooting
Possible problem Possible solution

Collected data is different from
transmitted data

• Verify the clock settings in the sensor.
• Make sure that there is no extra averaging or data collection in the setup.
• Verify the data output settings.

Problems with sensor-to-
software communication

• Make sure that the sensor–PC cable is connected correctly.
• Make sure that the current software and firmware are installed.

Self-test fails to complete Make sure that the sensor has an external power source; external power is necessary to
turn on the lamp.

Data warnings and error
messages

Contact Customer Support. If possible, have the information listed below:

• screenshot of the "Application Console" of the software.
• "messages.log" file—go to the Transfer Files window and select the Log Files tab.

Copy the file to the PC for Customer Support.

Negative nitrate concentration Clean the optical area and check the reference spectrum. Apply a new one if necessary.

• Make sure that the sensor is in water.
• Make sure that the "Deploy in Fresh Water" box has the appropriate check in it.
• Verify the salinity compensation.

Analysis of nitrate standard
shows sensor is possibly out of
specification

Make sure that the nitrate standard concentrations are accurate. Make sure the dilutions
were done correctly and that the standards are used within 1 week (in the lab) or before
expiration (unopened standards). Verify that the standards were made in comparable units
(mg/L as nitrogen or µMoles).

Verify the sensor settings. Make sure that the "Deployed in Fresh Water" setting has a
check in the box if the sensor operates in fresh water.

Poor correlation with field
samples (grab samples)

Look at the sensor for fouling or lamp change ("drift"). Clean the optical windows and do a
blank test.

• Set the sensor to do a self-test. Check light:dark counts, such as high CDOM or other
absorbers and other data about the sensor.

• Look for matrix interferences that can cause measurement errors. Do measurements
for a wider range of constituents an do possible lab matrix spikes to isolate the cause.

Verify the representativeness of the data collection site. If the data from the sensor does
not agree with grab samples but shows good performance, the site may not be
representative of conditions, or the water is not well mixed.

Data collection rate is very slow Verify that the internal memory is on. Data collection starts after approximately 5 seconds.

Verify that the "adaptive integration" is on. Data collection starts after approximately
500 milliseconds (20 × "integration period").

Nitrate values are not stable • Make sure that the optical area is not blocked with debris.
• Make sure that the wiper functions correctly.
• Clean and dry the optical area.
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Possible problem Possible solution

Nitrate value are frequently "-1"
or "NAN"

Make sure that the lamp intensity is sufficient. Measure the spectrum in DI or tap water.
Maximum output is > 10000. For best case, > 30000.

Look at the data: if the maximum is < 1000 and the lamp intensity is sufficient, the water
sample is optically dense.

SELFTEST alert for lamp
intensity or high humidity

Does the sensor have high internal humidity? Do a "selftest":
if humidity is > 50%, the sensor may have a leak. Contact Customer Support.
if humdity is > 30%, the sensor is probably ok. Contact Customer Support.

6.2 SUNA warnings and error messages
Possible problem Possible solution

Data warnings and error
messages

Contact Customer Support. If possible, have the information listed below:

• screenshot of the "Application Console" of the software.
• "messages.log" file—go to the Transfer Files window and select the Log Files tab.

Copy the file to the PC for Customer Support.

Negative nitrate concentration Clean the optical area and check the reference spectrum. Apply a new one if necessary.

• Make sure that the sensor is in water.
• Make sure that the "Deploy in Fresh Water" box has the appropriate check in it.
• Verify the salinity compensation.

Analysis of nitrate standard shows
sensor is possibly out of
specification

Make sure that the nitrate standard concentrations are accurate. Make sure the dilutions
were done correctly and that the standards are used within 1 week (in the lab) or before
expiration (unopened standards). Verify that the standards were made in comparable
units (mg/L as nitrogen or µMoles).

Verify the sensor settings. Make sure that the "Deployed in Fresh Water" setting has a
check in the box if the sensor operates in fresh water.

Poor correlation with field samples
(grab samples)

Look at the sensor for fouling or lamp change ("drift"). Clean the optical windows and do
a blank test.

• Set the sensor to do a self-test. Check light:dark counts, such as high CDOM or
other absorbers and other data about the sensor.

• Look for matrix interferences that can cause measurement errors. Do
measurements for a wider range of constituents an do possible lab matrix spikes to
isolate the cause.

Verify the representativeness of the data collection site. If the data from the sensor does
not agree with grab samples but shows good performance, the site may not be
representative of conditions, or the water is not well mixed.

Data collection rate is very slow Verify that the internal memory is on. Data collection starts after approximately
5 seconds.

Verify that the "adaptive integration" is on. Data collection starts after approximately
500 milliseconds (20 × "integration period").

Nitrate values are not stable • Make sure that the optical area is not blocked with debris.
• Make sure that the wiper functions correctly.
• Clean and dry the optical area.
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Possible problem Possible solution

Nitrate value are frequently "-1" or
"NAN"

Make sure that the lamp intensity is sufficient. Measure the spectrum in DI or tap water.
Maximum output is > 10000. For best case, > 30000.

Look at the data: if the maximum is < 1000 and the lamp intensity is sufficient, the water
sample is optically dense.

SELFTEST alert for lamp intensity
or high humidity

Does the sensor have high internal humidity? Do a "selftest":
if humidity is > 50%, the sensor may have a leak. Contact Customer Support.
if humdity is > 30%, the sensor is probably ok. Contact Customer Support.

6.3 HydroCAT and HydroCAT-EP troubleshooting
Possible problem Possible solution

Cannot communicate with
sensor

• Close the software, turn the power supply to the sensor off and disconnect the
communication connector at the PC. Turn the power supply back on, connect the
communication cable to the PC and start the software. Push Connect to start
communication again. Make sure that there is a check in the "try all baud rates" box.

• Make sure that the PC-sensor cable is connected correctly.

Sensor does not save collected
data

• Make sure that the memory is not full. If it is, save the data to a PC, then erase the
data stored in the sensor.

Zero conductivity check fails • Flush the sensor with DI water.
• Make sure to remove ALL water from the flow path and the conductivity cell.
• Make sure that the value on the conductivity certificate is entered correctly in the

software.
• HydroCAT-EP: make sure that the value on the conductivity certificate is the same as

the value stored in the sensor: enter "GetCC" in the terminal command area of the
software. Look for the "<Z>" value.

Optics calibration check fails • Make sure that the calibration check cap is installed correctly. The cap should be
straight, with the pin on the cap in the notch on the sensor.

• Clean the optical face.
• Make sure that the calibration cap is clean. Examine the orange glass for dust, water

spots, or other contamination. Clean if necessary.

pH calibration fails • Make sure that the standard solutions are not expired.
• Make sure that the standard solutions, the DI water and the sensor are at the same

temperature.
• Make sure that the probe is moist. If it is dry, fill the soaker cap with pH 4 standard

and soak the probe for 24 hours.
• If the pH output values are A) unstable, slow, or "drift," or B) the sensor cannot be

calibrated, refer to the hardware manual for details about how to replace the
electrolytes and Teflon™ junction.

• Refer to the hardware manual for details about how to remove and clean the probe.
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Section 7 General information

Revised editions of this user manual are on the manufacturer's website.

7.1 Service and support
The manufacturer recommends that sensors be sent back to the manufacturer annually to
be cleaned, calibrated, and for standard maintenance.
Refer to the website for FAQs and technical notes, or contact the manufacturer for
support at support@seabird.com.
Do the steps below to send a sensor back to the manufacturer.

1. Contact the manufacturer for a Return Merchandise Authorization (RMA).
Note: The manufacturer is not responsible for damage to the sensor during return shipment.

2. Remove all anti-fouling treatment from the sensor before sending it back to the
manufacturer.
Note: The manufacturer will not accept sensors that have been treated with anti-fouling
compounds for service or repair. This includes tri-butyl tin, marine anti-fouling paint, ablative
coatings, etc.

3. Use the sensor's original ruggedized shipping case to send the sensor back to the
manufacturer.

4. Write the RMA number on the outside of the shipping case and on the packing list.
5. Use 3rd-day air to ship the sensor back to the manufacturer. Do not use ground

shipping.
6. The manufacturer will supply all replacement parts and labor and pay to send the

sensor back to the user via 3rd-day air shipping.
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